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Instructor Introductions
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Participant Introductions

« Name

* Role

» Experience with USA Staffing or Cognos
» Desired outcome for the course
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Links & Shortcuts

URL Stage Access: https://stage.usastaffing.gov

URL Production Access: https://usastaffing.gov

Clear Browser History

Ctrl + Shift + Delete

(From within browser)
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USA Staffing Data Structure
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Overview of the Staffing Process

USA Staffing is the U.S. Office of Personnel Management's talent
acquisition system:; it is organized around the staffing process

O O O O

Request Vacancy Announcement Applications
A request to fill a Vacancy(s) created Announcement and Individuals apply for
position is initiated Assessment content the position
is created and
opened
Referral Selection Onboarding New Hire
Applicants are Manager selects Selected applicants Applicant completes
reviewed and applicants and HR complete forms and process and enters
referrals lists sent to  audits the certificate remaining process on duty
Manager
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USA Staffing

USA Staffing Data Packages

Package Name Update Frequency

Applicant Flow Data
Analytics

Hiring Data Warehouse

Staffing Administration

User License

Staffing Reports

Time to Hire

Demographic data voluntarily disclosed by
applicants. Includes gender, race, ethnicity and
disability status.

New data model to report on all USA Staffing
transactions. Optimized for fast performance

Administrative content on Cognos Users,
Organization info, and Position Descriptions

Data model to track User Licenses and Accounts

Data model covering all USA Staffing subject
areas

Standardized, pre-calculated metrics for time to
hire reporting, including milestones in the hiring
process

Daily
Every 6 to 10

hours (3x per day)

Real-time

Every 8 to 10
hours (3x per day)

Real-time

Every 8 to 10
hours (3x per day)

Pll not included; only data for
vacancies where announcement is
closed and all certs audited

Covers nearly all subject areas.
Try this package first when
building a report

Comprehensive USA Staffing data
package. A good alternative if a
data item isn’t available in the
Hiring Data Warehouse

All time to hire reporting
should be done through this
package
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Data Package Structure

Data packages are separated into distinct namespaces; each namespace is
designed to capture all data needed for analysis on a specific topic

USA Staffing® B+ 2 o

Report > Pages > Pagel * Namespaces divide data into
Insertable objects n analytical areas to ensure links between

data elements are optimized for
reportin
o porting
Namespace SrEE—— . FoI(EIers are used to organize query
> [3 Announcements Ssu bJeCtS
> [ Applicants
z EQPF’"C'M"SP ) * New query subjects and items are
ssessment Pac ages i
B Certicates : regularly added to namespaces to
> [0 Certificats Fiter Information ensure users can build reports in one
Folder v B3 Certificate Information .
——— namespace at a time
Query Su bject ~ [ Certificate Applicants
abe Certificate Applicant Address City o Query itemS from more than one
abc Certificate Applicant Address Gountry
Query Item abe Certificate Applicant Address Line 1 namespace can':‘Ot be added to the
abe Certificate Applicant Address Line 2 same report Object
+ abe Certificate Applicant Address Line 3 -
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Cognos Package Outline Report

The Cognos Package Outline report provides the location, description, and
data type for each data item in the each data package available in Cognos

Cognos Package Outline Report

Model Name  Namespace Query Subject Query Item Description Data Type

Staffing | Applications| Announcement] Announcement| announcement Close )
A The calendar date that an announcement is closed. date
Reports Detail Date

Announcement Control .
Number The USAIOBS provided control number. nt64
Announcement The first and last name, email address and phone number of the point of contact responsible for h terlenathi6
External Contact Mame| answering guestions about the announcement cutside the organization. character-eng
Announcement The first and last name, email address and phone numbker of the point of contact responsible far h terlenathi6
Internal Contact Name| answering questions about the announcement inside the organization. character-eng
agloaigéement Is Flag indicating if the Announcement is currently released. characterLength16
Announcement Last The ti + fth . th b was dified dateTi
Update Date/Time e timestamp of the last time the announcement was modified. ateTime
Announcement . . . . E .
Maximum Salary Maximum salary associated with the position being posted to US&I0BS. decimal
Announcement L . - E .
Minimum Salary Minimum salary assocated with the position being posted to USAJOBS. decimal
Announcement Mot To A ) _— ; .
Exceed Description of the appointment type, superficially the special duration. characterLength16
Announcement Identification number assigned to the job announcement by the TAS {also known as Requisition h terlenathi6
Number Mumber for some vendors). characterLeng

Team Content> USA Staffing Packages and Folders > Cognos Package Outline Report
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Cognos Reports List

The Cognos Reports List provides the location, title, and description for each
report a user has access to, including standard reports and custom reports for
offices and organizations to which they have permissions.

Cognos Reports List

Package

Applicant Flow Data
Analytics

Data Dictionary
Interim Upgrade AFD
Staffing

Administration

Staffing Analytics

Vacancy Application Detail
Report

Vacancy Number Summary
Report

Vacancy Office Summary
Report

Vacancy Organization
Summary Report

Cognos Package Outline
Report

Interim MD-715 A7 Report

Cognos Report Author List

Customer List by Office
Report

All Stage User Accounts

The Vacancy Application Detail Report displays application demographic i

data at the application level.

The Vacancy Application Detail Report di

data at the application level.

The Vacancy Office Summary Report displays

summarized by Office

and Folders > Applicant Flow Data > Applicant Flow Data Analytics > Vacancy

USA Staffing Packages and Folders > Applicant Flow Data > Applicant Flow Data Analytics > Vacancy

The Vacancy Organization S
i data

and Folders > Applicant Flow Data > Applicant Flow Data Analytics > Vacancy

and hiring mil USA Packag
Application Detail Report
play licati graphic resp and hiring
Number Summary Report
grap P and hiring milests data USA g P:
Office Summary Report
y Report displays appli demographic resp and hiring

ized by Or

The Cognos Package Outline Report provides a list of all data fields with descriptions and datatype for each

Cognos package

Lists basic user information for all Report Authors for a given Organization/Office.

The Customer List by Office Report display

the list of

s a

d with each office.

USA Staffing Packages and Folders > Applicant Flow Data > Appli

Flow Data Analyti
Organization Summary Report

> Vacancy

USA Staffing Packages and Folders > Cognos Package Outline Report

USA Staffing Packages and Folders > Applicant Flow Data > Interim Upgrade AFD > Interim MD-715 A7
Report

USA Staffing Packages and Folders > Staffing Administration > Cognos Report Author List

USA Staffing Packages and Folders > Staffing Administration > Customer List by Office Report

USA Staffing Packages and Folders > VA > Office Shared > VA HQ Program Office > Users > All Stage
User Accounts

Team Content> USA Staffing Packages and Folders > Cognos Reports List
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Overview of Applicant Flow Data
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What is Applicant Flow Data?

Demographic information is voluntarily collected from job seekers in
the USAJOBS profile and combined with milestones in the hiring process
in USA Staffing

Typically, over 80% of Demographic information
applicants disclose includes sex, ethnicity
demographic information and race, disability, and

: : = = : veterans’ preference
/ ,
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Applied = Qualified = Referred = Selected

All applications received for The applications that meet The applications that were The applications that were
a Vacancy the minimum qualifications referred to the hiring audited by HR as “Hired”
for the job manager for consideration
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How is Applicant Flow Data Collected?

Demographic information from the job seeker’s USAJOBS Profile is
included when they submit a job application

== An official website of the United States Government.

USAJOBS =l 2

B2 An official website of the United States Government

USAJOBS - I

& MyAccount Contact  Eligibility ~ Demographics  Account  Other
Include Personal

nalys )
agemen o
S Select eview
& Profile tesume ackage Info

% Resumes PI'OﬁlE

Q saved Searches Demographics

Your Privacy Is Protected
& Inbox 4 Your demographic information will not be sent to the hiring manager responsible for this position. It is used solely for statistical purposes
B Saved Jobs This information is used to determine if our recruitment efforts are reaching all segments of the population, consistent to assist the agency in the development of recruiting plans and to ensure the agency is reaching all segments of the population.

with Federal equal employment nity laws. Your voluntary responses are treated in a highly confidential manner.

(7] saved Documents Your responses are not released to the panel rating the applications, to the selecting official, to anyone else who can

affect your application, or to the public. No information taken from this form is ever placed in your Personnel file. Thisis I nclu d e Pe rsona l I nfo rmatio n

vital information not available from any other source. We can only get it directly from you. @

(@ Application Status

Completion of this form is voluntary. No individual personnel selections are made based on this information. There will | ivolunteer to provide my demographic information to hel
be naimpact on your application if you choose not to answer any of these questions. ine if the government’s equal ent opportunity
efforts are reaching all segments of the population.

USAJOBS Profile = Job Applications

Job seekers provide responses to Applicants opt to include the
demographic questions when demographic information from

they build a USAJOBS profile. The their USAJOBS profile to

USAJOBS profile can be updated at individual job applications.

any time by the applicant. Applicants can opt in or out for
each job application.
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How is Applicant Flow Data Collected?

Sex and Ethnicity/Race and National Origin

USAJOBS o

Help Search
& My Account Contact  Eligibility ~ Demographics  Account  Other
| & Profile
a Resumes Pl'Oﬁle
Q, Saved Searches Demographics
& Inbox Your Privacy Is Protected
B Soved Jobs This information is used to determine if ur recruitment efforts are reaching all segments of the population, consistent

with Federal equal employment opportunity laws. Your voluntary responses are treated in a highly confidential manner.

€F] Saved Documents Your responses are not released to the panel rating the applications, to the selecting official, to anyone else wha can

(2 Application Status affect your application, or to the public. Noinformation taken from this form is ever placed in your Personnel file. This is

vital informatian not available fram any other source. We can only get it directly from you. @

Completion of this form is veluntary, No individual personnel selections are made based on this information. There will

be no impact on your application if you choose not to answer any of these questions.

\:I | wish to decline to respond to the demographic questions.

1. Sex:

Male

2. Ethnicity:

) Hispanic or Latino - a person of Cuban, Mexican, Puerta
Rican, South or Central American, or other Spanish culture or

origin, regardless of race

/Mot Hispanic or Latino

3. Race (Check all that apply):

(] American Indian or Alaska Native - a person having origins in
any of the original peoples of Narth or South America (including
Central America), and who maintains tribal affiliation or
community attachment.

EI Asian - a person having origins in any of the original peoples
of the Far East, Southeast Asia, or the Indian subcontinent,
including, for example, Cambaodia, China, India, Japan, Korea,
Malaysia, Pakistan, the Philippine Islands, Thailand, or Vietnam.
[ Black or African American - a person having origins in any of
the black racial groups of Africa.

[] Native Hawaiian or Other Pacific Islander - a person having
origins in any of the original peoples of Hawaii, Guam, Samoa, or
other Pacific islands.

) White-a person having origins in any of the original peoples
of Europe, the Middle East, or North Africa.

Disability

4, Disability/Sericus Health Condition:

The next questions address disability and serious health conditions. Your responses will ensure that our outreach and
recruitment policies are reaching a wide range of individuals with physical or mental conditions. Consider your answers
without the use of medication and aids (except eyeglasses) or the help of another person.

A. Do you have any of the following?

Check all boxes that apply to you:
(] Deaf or serious difficulty hearing
[:J Blind or serious difficulty seeing even when wearing glasses
I:‘ Missing an arm, leg, hand, or foot
[:\ Paralysis: Partial or complete paralysis (any cause)
[j Significant Disfigurement: for example, severe
disfigurements caused by burns, wounds, accidents, or
congenital disorders
[ Significant Mobility Impairment: for sxample, uses a
wheelchair, scooter, walker or uses a leg brace to walk
[:‘ Significant Psychiatric Disorder: for example, bipolar
disorder, schizophrenia, PTSD, or major depression
[j Intellectual Disability (formerly described as mental
retardation)
[J Developmental Disability: for example, cerebral palsy or
autism spectrum disorder
(] Traumatic Brain Injury
) Dwarfism
[} Epilepsy or other seizure disorder
(") Other disability or serious health condition: for example,
diabetes, cancer, cardiovascular disease, anxiety disorder, or HIV
infection; aleaming disability, a speech impairment, or a hearing
impairment

Ifyou did not select one of the options above, please indicate
whether:

[) None of the conditions listed above apply to me.

D I do not wish to answer questions regarding disability/health
conditions.

If you have indicated that you have one of the above conditions, you may be eligible to apply under Schedule A Hiring

Autharity. For more information, please see http://www.opm.gov/policy-data-oversight/disability-

employment/hiring/#url=Schedule-A-Hiring-Authority.

Paperwork Reduction and Privacy Act Statement

Source Form:
https://www.eeoc.qov/sites/default/files/migrated files/fe

deral/2017-approved-Applicant-Form.pdf
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How is Applicant Flow Data Collected?

Veterans' Preference

3. Are you a Veteran of the U.5. Armed Forces or are you eligible Definitions
for "derived” preference?
Yes () No

® Do you claim Veterans' Preference? ° _Job Seekers claim veterans'
Mo, | do not claim Veterans' Preference preference in their USAJOBS
) 0-point Sole Survivorship Preference (SSP) proﬁle and u p|0ad su pporting
5-point preference based on active duty in the U.5. Armed .
Forces (TP) documentation
10-point preference based on a compensable service
connected disability of at least 10% but less than 30% (CP) ° H R profeSSIOna |S adjudicate
10-point preference based on a compensable service ’
connected disability of 30% or more (CPS) veterans preference by
10-point preference for non-compensable disability or ve rlfyl ng dOCU mentatlon
i g during the hiring process

() 10-point preference based on widow/widower or mother of a

deceased veteran, or spouse or mother of a disabled veteran (XP)

Veterans' Preference Guidance: https://www.opm.gov/policy-data-oversight/veterans-employment-
initiative/vet-quide/#2Types
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Guidelines for Use of Applicant Flow Data

USAJOBS Profile

Purpose and Routine Uses for Demographic Information

We are requesting demographic information under the authority of 5 U.5.C. §5 1302, 3301, 3304, 7201; 42
U.5.C. § 2000e-16; 29 U.5.C. §791. Providing your demographic information is veluntary, and there are no
adverse effects if you choose not to provide it. Demographic information will be used to determine if our
recruitment efforts are reaching all segments of the population, consistent with Federal equal
employment opportunity laws. Possible routine uses of the information collected includes releasing
information to the following:

4. to a Federal agency for use in its Federal Equal Opportunity Recruitment Program to the extent that the
information is relevant and necessary to the agency’s efforts in identifying possible sources for minority
recruitment;

1. to the Equal Employment Opportunity Commission (EEQC), for use in the examination of an agency's
compliance with affirmative action plan instructions and the Uniform Guidelines on Employes
Selection Procedures, or other requirements imposed on agencies under EEOC authorities in

connection with agency EEQ programs;

2. to the Merit Systems Protection Board or the Office of the Special Counsel in connection with the
processing of appeals, special studies relating to the civil service and other merit systems in the
executive branch, investigations into allegations of prohibited personnel practices, and such other

functions; e.g., as prescribed in 5 U.5.C. chapter 12, or as authorized by law;

3. by OPM or employing agency maintaining the records to locate individuals for personnel research or
survey response and in the production of summary descriptive statistics and analytical studies in

support of the function for which the records are collected and maintained, or for related workforce

studies;

5. to Congressional office in response to an inquiry made by the individual whose record is requested;

6. to another Federal agency, to a court, or a party in litigation before a court or in an administrative
proceeding being conducted by a Federal agency, when the Government is party to a judicial or

administrative proceeding;

7. to the U.S. Department of Justice, or in a proceeding before a court, adjudicative body or other

administrative body before which OPM is authorized to appear;

8. to disclose, in response to a request for discovery or for appearance of a witness, information that is
relevant to the subject matter involved in a pending judicial or administrative proceeding;

9. to contractors, grantees, or volunteers performing or working on a contract, service, grant cooperative
agreement, or job for the Federal Government.

Your voluntary responses are treated in a highly confidential manner. Your responses are not released to
the panel rating the applications, to the selecting official, or to anyone else who can affect your
application. This is vital information not available from any other source. No individual personnel
selections are made based on this information. No information taken from this form is ever placed in your
Personnel file.

...to the Equal Employment Opportunity Commission for use in the examination of an

agency'’'s compliance with EEOC requirements

...In the production of summary descriptive statistics and analytical studies

...to a Federal agency for use in its Federal Equal Opportunity Recruitment Program
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Guidelines for Use of Applicant Flow Data

Applicant Flow Data may be used for:

A. Aggregate human capital reporting

B. Determining rates of demographic representation in recruitment efforts

C. Determining rates of demographic representation in hiring or merit
promotion selections

D. Determining rates of qualifications among demographic groups

E. Evaluating the effectiveness of recruitment in reaching targeted
demographic groups

Applicant Flow Data may not be used for:

Influencing the decision to close or extend job announcements
Influencing the decision to cancel recruitment actions

Influencing the decision to use or not use a referral list of applicants
Influencing selection decisions

|dentifying the race, ethnicity, or gender of specific named employees

moN®

Rules of Behavior:
https://help.usastaffing.gov/ResourceCenter/images/c/cf/Applicant Flow Data Access SOP 10-

25-19.pdf




USA Staffing

Guidelines for Use of Applicant Flow Data

USA Staffing has implemented a number of safeguards to prevent the
misuse of Applicant Flow Data.

Your voluntary responses are treated in a highly confidential manner. Your responses are not released to
the panel rating the applications, to the selecting official, or to anyone else who can affect your
application. This is vital information not available from any other source. No individual personnel

selections are made based on this infarmation. No information taken from this form is ever placed in your

Personnel file.

Access Availability No Pll
Access is not granted Data are only released Personally-identifiable
automatically — vetting after hiring actions are information is not
and approval required complete (certificates included in the data

audited) provided
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Guidelines for Use of Applicant Flow Data

AFD is made available to users only if the vacancy is inactive, defined by these two
conditions:

< The announcement is not currently open
4 All certificates for a vacancy are audited or cancelled

If either of these conditions is not met, AFD will not be visible to users.

Additionally, if a previously inactive vacancy becomes active (e.g. the announcement is
re-opened, an additional cert is issued, or a cert is un-audited), AFD for that vacancy
will no longer be visible

o

0 l I
P et { ]
L H ]

* Announcement Opens + Certificates Issued to Hiring Manager * Inactive vacancies are
+ People apply for the job « Hiring Manager makes Selections added to ‘the AFD
* Announcement Closes ./ * HR reviews and audits all certs ./ dataset nightly
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Introduction to Cognos
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Accessing Cognos

USA Staffing Login
https://usastaffing.gov

USA Staffin

Sign in with smart card

Reset Password

Sign In

Report Author

Staffing User Access Only Access

USA Stoffing@‘ & Starfing e Reports : LISA Staffing”

DASHBOARD ~

7] Tasks A Requests 2= New Hires ] ‘ |

[ 4
Hello. Welcome to ' 0
Tasks (85) Reporting and l N

Analytics.
Favorites Only: [] | HRFive v | Active v | AllTasks N
Unearth hidden insights with a ‘
Task Vacancy Number Request Number personalized analytics experience
driven by Al

Initiate Childcare Background Checks for Leslie Knope 10002131 20160329-57960

Complete Assessment Package 10001027 REQUEST-2
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Navigating the Welcome Page

The Welcome Page allows users to navigate and search for reporting
content

Show/hide Cognos welcome

SearCh USA Staffing’
affing’
Search for reports °
and models Show welcome c.
Hello. Welcome to Reporting and Analytics.
My Content
Find your personal
yrepOFl?tS Recent =
T c Dashboard E : @ :
. eam Content £ Report “ask Data Self Service Vacancy Dat...elf Service  Country comparison
Flnd Shared reports Report Report Dashboard
& Story
New [? Job
Report AUthorS Can oo ast modified Last modified Last modified
12/16/2021,12:42 PM 12/16/2021,12:41 PM 8/20/2021, 2:17 PM
create new Reports, \)
Dashboards, and \ > = o ’
Stories Y

Recent
View recently accessed reports
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Navigating to Standard Reports

USA Stofflngﬁ ) Staffing Admin Reports Search

DASHBOARD ~

& Tasks 4 Requests 2% New Hires

Tasks (85)

Direct access to Cognos
, standard reports in the
ey | e e interface via single sign-on

10002131 20160329-57960

Favorites Only: [] = HRFive v | Active

Task

Initiate Childcare Background Checks for Leslie Knope

Complete Assessment Package 10001027 REQUEST-2

USA Staffing’ Welcome

Recruitment Sources By Vacancy Report

Hello. Welcome to Reporting and Analytics.

Staffing Organization Staffing Office Customer Name x‘:ﬁg‘rf Announcement Number Open Date

ASMG Internal Release Matt's House Clash of Clans - Fan Club 10015977 S5T-10015977-17-TA 02/17/2017

esting
Recent %

10051843 ST-10051843-18-TA 10/12/2017
Applicant T... Dashbaord Announcem...ashboard Announcem...as. Infinity Regression Cleveland Staffing  Bourbon Distillery 10015514 DE-10015514-17-10 02/14/2017
Office
Report Report Report OPM Program Program Office Account Management 10021066 DE-10021066-17-TH 03/05/2017
Branch \
10021662 IMP-10021662-17-TH 03/06/2017
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Navigating to Standard Reports

Future: Access to certain standard reports directly from the USA Staffing
interface via report buttons on select pages.

USA Staffing® #&  Sffing  Admin  Reports  Search B = 2 cooomna v
VACANCY 10003083 ~

Report Button

USAJOBS Job Title Pay Plan Series Crade Status
Aerospace Engineer GS-0861-11/12/13 Active ~

@ There are applicant notifications that need to be sentt

& Tasks (4)

uuuuuuuuuuuu

opENER  cLosEo

Reports are
filtered based on
page content

4 Requests (1)

.
EXa I I l p | es. rganization i : n o ame Applicant First ADD'IFaﬂt Middle Applicant Email

° Ap p | i Ca nt Li St by Va Ca n Cy Applicant Fantastic jaciarillo@icloud.com AC
. )] Bluth George georgebluthtest@amail.com AR
¢ Va Ca n Cy Ove rvi eW Bluth Lucille lucillebluthtestmamail.com aa

e Certificate Overview N
° Ap p | i Ca nt Ove rvi eW Eriksan Marshall marshall.zriksen.staffing@amail.com AC

Hanks Tom jsciarl+2@gmail.com As
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USA Staffing® &~

e o

Pages > Pagel

@ Report >

Insertable objects o
‘lg 1] 8
Q, Find [+]

~ 2 Hiring Data Warehouse
v T Presentation View
v B3 Announcements
~ B Announcement Information
~ {8 Announcement

@© Announcement Close Date
(© Announcement Last Modified [
abe Announcement Locations
abe Announcement Number
@© Announcement Open Date
@ Announcement Released Date.
abe Announcement Released?
abc Announcement Status
abc Announcement Template

# Aoplication Limit

Custom Reporting

Ability to modify existing reports and develop custom reports based on
USA Staffing data models

New report *

&  Pagedesign v <

A S = R ) W vy~ By £« T B & Qv Ev Udv

& Announcement Number Announcement Open Date Announcement Close Date Announcement Status USAJOBS Job Status
<Announcement <Announcement Open <Announcement Close <Announcement <USAJOBS Job
Number> Date> Date> Status> Status>
<Announcement <Announcement Open <Announcement Close <Announcement <USAJOBS Job
Number> Date> Date> Status> Status>
<Announcement <Announcement Open <Announcement Close <Announcement <USAJOBS Job
Number> Date> Date> Status> Status>

Cognos Report
Elements:
« List

 Crosstab
e Charts
* Visualizations

Output to:

« PDF

* Excel

» Excel Data
« HTML

« CSV

« XML
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Cognos Reports List

The Cognos Reports List provides the location, title, and description for each
report a user has access to, including standard reports and custom reports for
offices and organizations to which they have permissions.

Cognos Reports List

Package

(Applicant Flow Data
Analytics

Data Dictionary
Interim Upgrade AFD
Staffing

[Administration

Staffing Analytics

Vacancy Application Detail
Report

Vacancy Number Summary
Report

Vacancy Office Summary
Report

Vacancy Organization
Summary Report

Cognos Package Outline
Report

Interim MD-T15 AT Report

Cognos Report Author List

Customer List by Office
Report

All 5tage User Accounts

The Vacancy Application Detail Report displays application demographic responses and hiring milestone
data at the application level.

The Vacancy Application Detail Report displays application demographic responses and hiring milestone
data at the application level.

The Vacaney Office Summary Report displays application demographic responses and hiring milestone data
summarized by Office

The Vacancy Organization Summary Report displays application demographic responses and hiring
milestone data summarized by Organization

The Cognos Package Outline Report provides a list of all data fields with descriptions and datatype for each
Cognos package

Lists basic user information for all Report Authors for a given Organization/Office.

The Customer List by Office Report displays the list of customers associated with each office.

USA Staffing Packages and Folders > Applicant Flow Data > Applicant Flow Data Analytics = Vacancy
Application Detail Report

USA Staffing Packages and Folders = Applicant Flow Data = Applicant Flow Data Analytics = Vacancy
Number Summary Report

USA Staffing Packages and Folders > Applicant Flow Data > Applicant Flow Data Analytics = Vacancy
Office Summary Report

USA Staffing Packages and Folders = Applicant Flow Data = Applicant Flow Data Analytics = Vacancy
Organization Summary Report

USA Staffing Packages and Folders > Cognos Package Cutline Report

USA Staffing Packages and Folders = Applicant Flow Data = Interim Upgrade AFD = Interim MD-715 A7
Report

USA Staffing Packages and Folders > 5taffing Administration > Cognos Report Author List

US5A Staffing Packages and Folders > 5taffing Administration > Customer List by Office Report

USA Staffing Packages and Folders » VA = Office Shared > VA HQ Program Office > Users = All Stage
User Accounts

Team Content> USA Staffing Packages and Folders > Cognos Reports List
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Running an Existing Report

1. Locate Report

Navigate to the desired 3. Export Report >~ C
report through Team Reports can be run and S Run HTML

Content exported as HTML, PDF,

Excel, CSV, or XML Run PDF

USA Staffing’

5 Run Excel

@ > Certificate Vo USA StOff|n9® EJ v 2

Certificate Activity Dashboard
] 11/16/2021 11:23 AM _f_ A - o= wsg Run Excel data
Certificate Activity Report certl lcate CtIVlty
@ 9/14/2021 10:04 PM

| Run CSV
Certificate Overview Report

12/14/2021 9:42 AM Description: Tabular data summarizing the number of certific

©@ k [0 O
&

B Certificate Review Detail Report ) Run XML
9/15/2021 2:18 PM
Parameters:

B Certificate Status Dashboard ” Required Filter(s)
8/2/2021 2:54 PM

Select one or more Organizations:

Certificate Status Report
@ 8/26/2021 8:19 AM .
[J Administrative Office of the US Courts
Referrals by Certificate
=) 9/15/2021 2:25PM [ Advisory Council on Historic Preservation
Selectees without Requests or Offers

m 10/19/2021 1:40 PM

[J African Development Foundation
[J Agricultural Marketing Service

[J Agricultural Research Service

2. Run Report
Enter prompt values and
run the report

L1 Air Force NAF e
Select all Deselect all

Next >
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ERSONNEY:

Running Reports Live vs. In the Background

Users can run reports live or set a report to run in the background and receive a
notification when the report has completed.

Live Reports Click the toggle to run a report

« Run immediately in the background
« Allow a single output format to be
selected for each run

» Allow a single report to be run at a

tlme QB Runin background
@ Promptme

You will be prompted for input before the report runs.

Run as

Background Reports

Q_ Find
» Can be run immediately or scheduled
to run at a certain time Format
» Allow multiple output formats to be
(@) HTML () PDF () Excel
selected for each run O ExcelData O csv O xmt
» Creates a queue of reports to be run; Accessibillty

reports may run simultaneously
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Running a Report in the Background

1. Locate Report
Navigate to the desired

report through Team 2. Click the ... and
Content select Run as
\> Announcement + ¢ 1 Run as

Announcement Status Dashboard B Runin background
m 1/3/2022 10:46 AM
Run as a
Announcement Status Report

EI 12/21/2021 2:31 PM Edit report YoN\will be prompted for input before the report runs.

rompt me

Create report view Q Find

View versions
Format
Share

(@ HTML O
O Excel Data O CS

F O Excel
O XML

Take ownership

Copy or move

3. Click Run in
background toggle

Create shortcut

Delete

Properties
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Running a Report in the Background

Run as

4. set Run options T:’ Send report by email

74

@D Runinbackground

N
i Run the report R
- immediately or at a S
D Show Run history details window after you click Run S peCIfI C tl me Sloiect
@ - A new version of Report Name is available
rompt me
You will be prompted for input before the report runs. o
5. Select report
Q. Find
format(s)
Format
HTML [] poF L [
Edit options
[] Excel Data [ csv ] xML @@ - ) E 4
Accessibility B.I U S x »|F M= = 4 | 99 || Styles «|| Format ~
[] Enable accessibility support
Include the following with my message
Deli B Include link
elivery

QI Attach report output

6. Set
Delivery @
method(s) N e g T g Rt 7.Click “Run” to finish
Click "Edit ‘l'

details” to edit My Folders

. . Select another location
email options

Cancel

Send report by email Edit details

No recipients
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Report Subscriptions

Cognos allows users to subscribe to any report to have report output delivered at
specified intervals

» Report subscriptions save report

O .
v — < & A0 output in your My Content
Subscribe « Users have to leave edit mode
When do you want to receive this report? before Su bSCI‘ibing; CognOS saves
the parameter values
Repeat on MO T WL T B S S .
» After a report is scheduled, users are
Time © 7:07 AM notified each time the report is run
Format HTML
Delivery M) save The use of Subscriptions is

recommended rather than Scheduling
Prompts 1 schedule prompt value as it provides greater flexibility and
minimizes the potential that report

output will be saved over the report

itself.
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Report Subscriptions

Cognos allows users to subscribe to any report to have report output delivered at
specified intervals

* To subscribe to a report, first leave edit mode.

 If the report has prompts, the prompt values you select will be remembered in your
subscription and used every time the report is run.

« From the report output click on the ellipsis, then click on Subscribe.

@ Staffing Office Name Announcement Open Days Set as home
API Test Office A

Q API Test Office D 368 Subscribe
Braavos 327.33333333

D Default Settings Test Office 6
Dorne 1234

[E’ Fixing Office 14.5
Myr 924

@ Office Alpha 30.65957447
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? Survey aee

Subscribe

Report Subscriptions

< O ©)

Jo

When do you want to receive this report?

Repeat on

Time

Format

Delivery

Prompts

® 7:07AM

HTML

@ Save

1 schedule prompt value

Users are unable to send reports
via email due to current security

settings

< Back Format

HTML
[poe] POF
Excel
Excel Data
csv

XML

< Back Delivery

@ Send report by email

ﬁ Print report

B_, Save to cloud

@ Save report

A menu pops up allowing
you to pick which day(s)
of the week to run the
report and what time to
run it.

If you choose Format you
can pick one or more
report output format(s)

If you choose Delivery
you can choose how to
receive the report results

Prompts will allow you to
view the prompt values
the report will run with,
but you can't change
them.
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Notifications

Report Subscriptions

NG

N\

g A new version of My Cognos Reports List

is available

Fletcher Smith
12/22/2021

My schedules and subscriptions

My preferences

Log my session

My Inbox

My Watch Items

About

Sign in

Sign out

My preferences

General Personal

Home page Default
Show hidden entries
Report format HTML >

Turn on accessibility features

Show hints

You will receive a notification in
Cognos when the report you
subscribed to runs.

Click on the bell icon to see the
notification

Subscribed reports are stored in a
hidden “Subscriptions” folder in My
Content

To display the hidden folder, click on
the user icon, select My Preferences,
and check the Show hidden entries
option

USA Staffing’

@ My content + ¢ 1

o Functional Testing
12/2/2021 2:35PM

7/13/2021 1:14 PM

['\_—] o Report Author Challenges

0o Subscriptions
5/17/2021 1:58 PM
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Q
A

My schedules and subscriptions

My preferences

Log my session

My Inbox

My Watch [tems

About

Schedule w

Report Subscriptions

To manage subscriptions, click on My schedules and subscriptions
from the User icon

Users can view Upcoming, Current, and Past subscriptions

Al

Sign in
Sign out Enabled - 1
Disabled | o
0
D Name

() > B MyCognos Reports List

Modified ™  Type Scheduled by Status Priority

5/17/2021 ©l

1:55 PM Fletcher Smith Enabled 3
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Standard Reports Overview
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Summary Reports



USA Staffing

Production Statistics Report

B0 Teamcontent > USA Staffing Packages and Folders > Staffing Reports > Staffing

This report provides data related to the most common production statistics (applications, announcements, certificates, selections,
tentative offers, official offers, and entry on duty). It contains multiple tabs which display these data in different contexts including
visualizations.

By Organization and Office By Month and Week Job Offers by Organization and Office Job Offers by Month and Week Applications by Month Chart Announcemel

Organization Name Office Name  Application Count Announcements Opened Count Certificates Issued Count Selections Made Count Entry on Duty Count
Office of Personnel Management OPM HR Boyers 26 7 3 1 1
OPM HR Macon 4 1 1 1
3 OPM HR TRB 33 1 6
[ Offce of Persomnel Management- Toial |63 | I T S R
Overall - Total 63 9 10 2 1

Announcements by Month Chart ~ Certificates by Month Chart Selections by Week Chart Tentative Offers Accepted by Month Chart Official Offers Accepted by Month Chart EODs by Month Chart

Required Prompts: | Query Items:

* Organization Name(s) * Organization Name * Certificates Issued Count
* Fiscal Year(s) » Office Name » Selections Made Count
* Application Count * Entry on Duty Count

* Announcements Opened Count
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Time to Hire Summary Report

Bl Teamcontent > USA Staffing Packages and Folders > Time to Hire

Summary Report displaying summary level data on the milestones of the hiring process and the overall time to hire.

Organization and Office Month and Week Series Overall T2H Dashboard Hiring Phase Dashboard Data Definitions
Time to Hire Summary Report (Completed Requests) - Organization and Office
JOA
Overall Days Request Review Certificate
D to Hire Approval Sent to JOA Review Announcement Certificate Returned Certificate Tentative Official
(Hiring Need to JOA JOA Returned to Close to Issued to to Audited to  Offer Sent Offer Sent
Requests Validated Review Review  Announcement Announcement Certificate Certificate Certificate Tentative to Official to Entry
Staffing Organization Name  Staffing Office Name Count Date) Sent Returned Open Open to Close Issued Returned Audited Offer Sent Offer Sent  on Duty
OPM Reimbursable Kansas City Services 2 21.0 0.0 3.5 0.0 3.5 -3.5 0.0 15.5
Branch
Philadelphia Services 1 13.0 19.0 -19.0 11.0 0.0 0.0
Branch
OPM Reimbursable Summary 3 183 | 63 40 00 35 13 00 103
2017 Summary 3 18.3 6.3 -4.0 0.0 3.5 1.3 0.0 10.3
Notes: Negatives may occur when milestone dates occur more than once (e.g. certificates re-audited).
H L] I L]
Required Prompts: | Query Items:
o : - * Announcemen n I
« Organization Name(s) » Staffing Organization Name ouncement Open to Close

- Fiscal Year(s) . Staffing Office Name » Announcement Close to Certificate Issued

- Requests Count » Certificate Issued to Certificate Returned

- Overall Days to Hire (Hiring Need Validated Date) ° Certificate Returned to Certificate Audited

- Request Approval to JOA Review Sent » Certificate Audited to Tentative Offer Sent

« JOA Review Sent to JOA Review Returned « Tentative Offer Sent to Official Offer Sent
Official Offer Sent to Entry on Duty (EOD)

» JOA Review Returned to Announcement Open
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Areas of Waste Report

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Tabular data including summary metrics to identify potential waste from cancelled vacancies and certificates, unreleased
vacancies, certificates without selections, certificate reviews that were recalled, and certificate reviews that are overdue.

v
Metrics Vacancies Not Released Vacancies Released without Applications Vacancies Cancelled Certificates Cancelled Certificates without Selections Certificate Reviews Returned Certificate Reviews Recalled Certificate Reviews Overdue Data DeﬁnitimG

Organizations: OPM Reimbursable

Offices: Kansas City Services Branch, Mid-Atlantic Services Branch, Philadelphia Services Branch, San Antonio Services Branch, San Francisco Services Branch, Washingten Services Branch

Vacancy Creation Date Range: Between Jan 1, 2020 and Jul 28, 2020

Staffing Staffing Office Name i Vi ies Not Vi ies Rel d without Vacancies Certificates Certificates Certificates without Certificate Reviews  Certificate Reviews Certificate Reviews Certificate Reviews

Organization Name Created Released Applications Cancelled Issued lled Selecti Created Recalled Returned Overdue

OPM Reimbursable  Kansas City Services 73 28 " 0 47 1 27 13 0 6 10
Branch
Mid-Atlantic Services 5 5 0 0 0 0 0 0 0 0 0
Branch
Philadelphia Services 108 35 21 2 54 0 14 28 12 17 0
Branch

Required Prompts: | Query Items: summary 7ab*
* Organization Name(s) « Staffing Organization Name  « Certificates Issued (count) Additional query items
« Office Name(s) - Staffing Office Name « Certificates Cancelled (count) are included in the
_ tabular data which
* Vacancy Creation Date » Vacancies Created (count) « Certificates without Selections (count) provide the details
. - . behind the summar
Range * Vacancies Not Released (count)s Certificate Reviews Created (count) metrics found on th);
* Vacancies Released without  « Certificate Reviews Recalled (count) Metrics tab. The Data
Dictionary tab
Applications (count) « Certificate Reviews Returned (count) provides a list of these
additional query items.

» Vacancies Cancelled (count)  « Certificate Reviews Overdue (count)
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Staffing Process Tracking Report

Eo

Team content > USA Staffing Packages and Folders > Hiring Data Warehouse

Tabular report displaying request, vacancy, announcement, and certificate numbers as well as milestone dates in the

Staffing Process Tracking Data Definitions

staffing process for New Vacancy and Additional Selection requests.

Staffing Process Tracking Report

Organizations:

)

Offices:

Staffing Date Type:

Staffing Date Range:

OPM Reimbursable

Kansas City Services Branch, Mid-Atlantic Services Branch, Philadelphia Services Branch, San Antonio Services

Branch, San Francisco Services Branch, Washington Services Branch

Announcement Close Date

Between Jan 1, 2020 12:00 AM and Jan 31, 2020 11:59 PM

Staffing Staffing Request Request Number Req Req Email Approver Approver Email
Organization  Office Customer Name Name
Name Name Name
OPM Kansas A Salah’s 20190918-59804 Robinson, dana.robinson@opm.gov HR, Test  usastesthr@opm.gov
Reimbursable City Test Dana
Services Customer
Required Prompts: | Query Items: )
- Organization Name(s) ¢ Announcement Close Date .
9 * Announcement Last Modified D/T .
« Office Name(s) * Announcement Number .
* Announcement Open Date .
- Staffing Date Range* * Announcement Released D/T .
R . e Announcement Released? .
* Request Creation
¢ Announcement Status .
* Request Approval . A | Date/Ti
+ Announcement. Open pproval Date/Time :
A ‘CI P * Approver Email .
nnpgncement ose . Approver Name .
* Certificate Issue Date + Certificate Amended? .
* Cert. Initial Audit + Certificate Audited By .
+ Cert. Final Audit » Certificate Audited? .

Customers:
Staffing Number Type:

Staffing Numbers:

Approvers:

R R t R t R t Ri
q q q 4 q
Type Status Creation Last Submission
Date/Time Modified Date/Time
Date/Time
New Active 09/18/2019 09/18/2019
Vacancy  Recruitment 08:10:56.937 08:11:21.163
AM AM
Certificate Cancelled? .

Certificate Final Audit Complete D/T -
Certificate Initial Audit Complete D/T

Certificate Issue Date/Time .
Certificate Issuer .
Certificate Last Modified Date/Time ¢
Certificate Number .
Certificate Refer Method .
Certificate Status .
Certificate Type .
External Contact Email .
External Contact Name .
Internal Contact Email .
Internal Contact Name .
Request Creation Date/Time .

Request Last Modified Date/Time .

All parameter options
All parameter options

All paramater options

All parameter options

Vi y Vac
Status T

Approval Vi y V. y Vi y
Date/Time Number Pay Job Title
Plan-
Series-

Grade

10091690 GS-
0201-5

09/18/2019
08:11:23.160
AM

Cas
Exa

HR Manager Active

Request Number
Request Status
Request Submission D/T
Request Type

Requester Email

Requester Name

Staffing Office Name

Staffing Organization Name
USAJOBS Control Number
Vacancy Announcement Types
Vacancy Creation Date
Vacancy Job Title

Vacancy Last Modified D/T
Vacancy Number

Vacancy Pay Plan-Series-Grade
Vacancy Status

* Vacancy Type
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MD-715 “A” Tables

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes summarized applicant responses to ethnicity/race and sex demographic questions in the
USAJOBS job seeker profile to respond to the MD-715 requirements for the "A" Tables (Mission Critical Occupations

Distribution by Race, Ethnicity, and Sex).

Total Applications Race, Ethnicity, and Sex Total Applications Race, Ethnicity, and Sex
MD-715 Announcement Type: Internal Competitive Promotion MD-715 Announcement Type: Internal Competitive Promotion

Occupational Series: 0201 - Human Resources Management

D Sex Response Total Applications | Qualified Applications Referred Applications = Selected Applications

Male 659 172
Female 1,381 461
Omitted 523

Qccupational Series: 0201 - Human Resources Management

D Sex and Ethnicity/Race Response Total Applications = Qualified Applications | Referred Applications S
108 5 Hispanic or Latino Males 39 15 9
285 7 Hispanic or Latino Females 165 50 24

White Males 208 56 39

176 134 8
—— White Females 272 87 59
s pplcatons 2663 | w8 a1 | m |
Black or African American Males 294 85 50

Required Prompts:
* Organization Name(s)
» Office Name(s)

* Fiscal Year(s)

Query ltems:

Announcement Type (slicer)

Sex Response (slicer)

Sex and Ethnicity/Race Response (slicer)
Total Applications (count)

Qualified Applications (count)

Referred Applications (counts)

Selected Applications (count)
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MD-715 “B” Tables

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes summarized applicant responses to disability questions in the USAJOBS job seeker profile to
respond to the MD-715 requirements for the "B" Tables (Mission Critical Occupations Distribution by Disability).

Total Applications Targsted Disabilities Total Applications Targsted Disabilities
MD-715 Announcement Type: Internal Competitive Promotion MD-715 Announcement Type: Internal Competitive Promotion
Occupational Series: 0343 - Management And Program Analysis Occupational Series: 0343 - Management And Program Analysis
D Total Disability Total Applications Qualified Applications = Referred Applications = Selected Applications D Targeted Disability Total Applications Qualified Applications =Referred Applications | Se
No Disability (05) 1202 584 364 ° Developmental Disability (2) 4 2 0
Not Identified (01) 1,260 648 450 15 Traumatic Brain Injury (3) 11 6 4
Disability (02-03, 06-99 268 151 69 2 . X .
isapility ( ’ ) Deaf or Serious Difficulty Hearing (19) 21 10 4
Total Applications 27% |t | s | 2 N S N - - -

Required Prompts: | Query Items:

* Organization Name(s) * Announcement Type (slicer)
» Office Name(s) + Disability (slicer)
* Fiscal Year(s)  Targeted Disability (slicer)

+ Total Applications (count)
* Qualified Applications (count)

» Referred Applications (counts)

 Selected Applications
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Announcement Status Dashboard

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Dashboard and tabular data showing the status of announcements to support HR user workload management.

Dashboard ~ All  Vacancies Pending Announcements ~ Open  Open - PendingRelease  Closing inthe Next5Days  Closed within the Last 5Days  Closed - Pending Certificates  Data Definitions

Announcement Status Dashboard

Staffing Staffing Vacancy C A A Vacancy Vacancy Job Title
: N N Closed Announcements Pending Organization Office Name Name Number Status Released? Number |
b Pending Open Announcements Open Pending Certifi Name
ertificates
0 2 3 192 Veteran's Health VAFederal NORTH CHICAGOIL  IMP-10095403- Removed No 10095403 HR SPECIALIST In
Administration Healthcare - P1577 - 5556 20-ME
Center
Announcements Closing in the Next 5 Days Announcements Closed within the Last 5 Days
204
Vacancy Announcement Announcement Internal Internal Contact Email External External Contact Email
15 Announcement Open Date Close Date Contact -ontact
Types Name Name
1P 117292019 12/06/2019 Moore Kiphanie. Moore@va.gov  Moore, Kiphanie. Moore@va.gov
Kiphanie Kiphanie

Number of Announcements
3
L

Number of Announcements

2
Days to Close Days since Close

Required Prompts: | Query Items:

* Organization Name(s) *  Vacancies Pending Announcement (count) Additional query items
are included in the

» Office Name(s) *  Open Announcements (count) )
tabular data which
* Announcement Close Date «  Open Announcements Pending Release (count) provide the details
. - behind the summary
Range *  Closed Announcements Pending Certificates (count) metrics found on the

Dashboard tab. The
Data Dictionary tab

«  Announcements Closed Within the Last 5 Days (bar graph) provides a list of these
additional query items.

*  Announcements Closing in the Next 5 Days (bar graph)
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Applicant Dashboard

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Dashboard and tabular data showing total applicants by eligibility and veterans preference for one or more vacancies.

Applications by Eligibility

Dashboard  ApplicantList  Applicants by Eligiilty  Applicant Summar y  DataDefinitions

Applicant Dashboard vEcA
228 200 142 49 PPP ;:‘;""Z:'
by Claimed feations by Adjudi ; NWDODM:Z? Adjudicated Eligibility
o 250 AF OAY [l Claimed @l Eligible [l Ineligible
Required Prompts: ;| Query Items:
. izati  Applications by Record Status Code (pie chart) + Total Referred (count . :
Organization Name(s) PP y (P ) ( ) Additional query items
+ Office Name(s) « Notification Messages by Grade (bar graph) + Total Hired (count) are included in the
o ] tabular data which
* Announcement Open Date » Applications by Claimed Veterans Preference (bar graph) provide the details
I - behind the summary
Range * Applications by Adjudicated Veterans Preference (bar graph) metrics found on the
« Applications by Eligibility (bar graph) Dashboard tab. The
Data Dictionary tab
+ Total Application (count) provides a list of these

.. additional query items.
+ Total Eligible (count)
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Certificate Activity Dashboard

B8 Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Visualizations and tabular data summarizing the number of certificates issued, certificates audited, and selections
made. The data is provided by vacancy, year, month, organization, and office.

Dashboard ~ ByVacaney ~ ByMonth  ByOrganizationand Office  Data Definitions

SD,
Certificate Activity Dashboard
Vacancies Certificates Issued Certificates Audited Selections @0 407
P £
132 185 118 137 2
£ 30
Certificates per Vacancy Selections per Vacancy Selections per Certificate 8
1.40 1.04 0.74 ; 20
Certificates Audited and Issued by Office Certificate Activity by Month ’ E
VHA VISN 8 SSU 10+
=) o [ [ [ [ 5n [ 50 [ =
VHC:E\':;&;‘Z“S‘E January | February | March April May June July
v:;c;\;ﬁ:u;a:;g — Issued — Audited — With Selections
Required Prompts: ;| Query Items:
¢ Organization Nam » Certificates Audited (count + Vacancies (count . .
Organization Name(s) ( ) ( ) Additional query items
» Office Name(s)  Selections (count)  Certificates Issued (count) are included in the
- tabular data which
 Certificate Issued Date * Certificates per Vacancy (avg count) provide the details
. behind the summary
Range * Selections per Vacancy (avg count) metrics found on the
« Selections per Certificate (avg count) Dashboard tab. The
Data Dictionary tab
* Certificates Audited and Issued by Office (bar graph) provides a list of these
additional query items.

+ Certificate Activity by Month (line graph)
47
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Request Overview Dashboard

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Visualizations and tabular data showing the status of requests.

Dashboard ~ ByRequest  ByOrganizationand Office  ByMonth  Data Definitions,

Request Overview Dashboard Requests by Status

New Vacancy Requests Additional Selection Requests Onboard New Hire Requests
U

Total Requests New Vacancy Requests Additional Selection Requests Onboard New Hire Requests
129 83 46 o

Requests by Office Requests Created by Year/Month

No Data Available

Active Recrutment  Incomplete  Pending Recrutment - Selection Made

Jul | Aug | Sep | Oct | Nov | Dec | Jan | Feb | Mar | Apr |
2018 202

0 20 40 60 80 100
[ New Vacancy Requests ([l Additional Selzction R... [l Onboard New Hire Req, —NH

Required Prompts: | Query Items:
* Organization Name(s) * Additional Selection Requests (count) « Total Requests (count) Additional query items
« Office Name(s) * Onboard New Hire Requests (count)  « New Vacancy Requests (count) @€ (ncluded in the
' tabular data which
* Request Creation Date * Requests by Office (bar graph) provide the details
Range  Additional Selection Requests by Task (bar graph) ﬁfgggs%zzzn;':ffg
« Onboard New Hire Requests by Status (bar graph) Dashboard tab. The
Data Dictionary tab
» Requests Created by Year/Month (line graph) provides a list of these
additional query items.

* New Vacancy Requests by Status (bar graph)
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Detail Reports
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Time to Hire Detail Report

Bl Teamcontent > USA Staffing Packages and Folders > Time to Hire

The Time to Hire - Detail Report displays detail level data on the milestones of the hiring process and the overall time to hire.

MNew Vac_Add'l Selection Data Definitions

Required Prompts:
* Organization Name(s)

* Fiscal Year(s)

Time to Hire Detail Report - New Vacancy & Additional Selection Request Types

01/10/2017 | 01/10/2017

Query ltems:

Announcement Close Date
Announcement Close to Cert Iss.
Announcement Number
Announcement Open Date
Announcement Open to Close

Certificate Initial Audit Date
Certificate Issue Date

Certificate Issued to Cert. Returned
Certificate Returned to Cert. Audit
Certificate Review Returned Date
Hiring Need Validated to Tent.
Offer Accepted

Certificate Audit to Tent. Offer Sent .

Hiring Need Validation Date (HNVD) ¢
Initiate Background Invest. Date
JOA Review Returned Date

JOA Review Returned to Ann. Open
JOA Review Sent Date

JOA Review Sent to Returned

New Hire Actual Start Date

New Hire Creation Date

New Hire Grade

New Hire Name

New Hire Number

New Hire Pay Plan

New Hire Position Title

New Hire Projected Start Date
New Hire Series

New Hire Staffing Customer

Initiate
) i Background
H Hiring JOA JOA Certificate = Certificate Sent Tentative Investigation
Staffing ;| Staffing Need Request Review Review Certificate  Review Initial Tentative Offer Security
Organization :  Office Request Reguest Vacancy Announcement Validation Approval Sent Returned A A Issue Returned Audit Offer Accepted Clearance
MName Name Number Type Number MNumber Date Date Date Date Open Date Close Date Date Date Date Date Date Date
OPM Kansas City | REQ- New 10006733 DE-10006733- | 09/14/2016 | 09/16/2016 09/16/2016 09/16/2016  09/19/2016 | 09/19/2016 | 09/18/2016 09/19/2016 09/19/2016
Reimbursable | Services 1111TEST | Vacancy 16-15
Branch Hiring Overall Official
§ Receive Need Days to JOA Tentative Offer
oPM Kansas City | REQ-2-2017 | New 10011328 |  DE-10011328- | 01/04/2017  gackground validated Hire | Request | Review Certificate Offer | Sent
Reimbursable | Services Vacancy 1735 Investigation  Sent | New Hire to (Hiring  Approval Sentto  JOA Review Announcement Certificate Returned | Certificate Sentto  to
Branch Security Formal Actual  Tentative Need to JOA JOA Returned to Clogg to ied to to Auditeq to Offidal Entry
oPM Philadelphia | DANATEST1 | New 10021998 | Customer B-17- | 03/15/2017 Clearance Offer Start Offer  Validated Review Review A ‘ement ement Certificate Certificate = Certificate Tentative offer on
Reimbursable | Services Vacancy 10021998-IMP Date Date Date Accepted Date) Sent Returned Open Open to Close Issued Returned  Audited = Offer Sent Sent Duty
- 09/19/2016 | 10/20/2016 36 0 3 0 0 0 0 31

New Hire Veterans Preference Status
Official Offer Sent to Entry on Duty
Overall Days to Hire (HNVD)

Receive Background Invest. Date
Request Approval Date

Request Approval to JOA Rvw. Sent
Request Number

Request Personnel Action Date
Request Type

Sent Formal Offer Date

Sent Tentative Offer Date

Staffing Office Name

Staffing Organization Name
Tentative Offer Accepted Date

Tent. Offer Sent to Official Offer Sent
Vacancy Number
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Applicant Flow Data Detail Report

BB Teamcontent > USA Staffing Packages and Folders > Applicant Flow Data » Applicant Flow Data Analytics

This report includes detailed data related to applicant responses to ethnicity/race and sex demographic questions in
the USAJOBS job seeker profile. Information gathered from this report can be aggregated to respond to MD-715 2.0
requirements or to complete other AFD analyses.

nt Application Application Application Applied Qualified Referred | Selected Not Not Application | Application Sex Ethnicity
Last Record Record Status  Indicator Indicator  Indicator Indicator Referred Referred - Claimed — Adjudicated Response and
| Submitted Status Code Description - Eligible \eterans Veterans Race
Date Code Ineligible ' Not on Preference | Preference Category
Indicator = Certificate = Description | Description
Indicator
12/27/2017 IN Ineligible for 1 0 0 0 1 0 NP - No Male Omitted
S Certificate Preference.
01/05/2018 IN Ineligible for 1 0 0 0 1 0 NP - No Female Omitted
Certificate Preference.
* MD-715 Announcement Type + Not Referred — Elig. Not on Cert. Indicator « Asjan Indicator
* Announcement Number * Native Hawaiian/Other Pac. Islander Ind.  « Status Code

. « _ * Announcement USAJOBS Control No.  « Application Claimed Vet. Preference Desc. « Applied Indicator
ReqUIred Prompts' * Announcement Who May Apply Name + Application Adjudicated Veterans Pref. Des. « Qualified Indicator
« Organization Name(s) * Announcement Who May Apply Override « American Indian or Alaska Native Indicator « Referred Indicator

* Announcement Last Released Date » Deaf or Serious Difficulty Hearing (19) « Selected Indicator
« Office Name(s) * Announcement Open Date + Blind or Serious Difficulty Seeing (20) + Sex Response
¢ Announcement Close Date * Sex-Ethnicity and Race Category « White Indicator
Quer ItemS' * Announcement Ext. Contact Full Name < Epilepsy or Other Seizure Disorders (82) + Disability Indicator
y » Application Applicant Unique Identifier + Significant Psychiatric Disorder (91) + Targeted Disability
Announcement Close Date + Application Last Submitted Date * Hispanic or Latino Indicator + No Disability (5)
* Vacancy Organization Name » Application Record + Significant Disfigurement (93) * Not Identified (1)
* Vacancy Office Name + Ethnicity and Race Category * Significant Mobility Impairment (40) * Missing Extremities (31)
* Vacancy Number » Vacancy USAJOBS Ann. Type (Is Public) + Partial or Complete Paralysis (60) + Intellectual Disability (90)
* Vacancy Pay Plan Series Grade » Vacancy USAJOBS Ann. Type (Is Status)  Black or Afr. American Indicator + Dwarfism (92)
* Vacancy USAJOBS Job Title + Application Record Status Code Desc.  « Developmental Disability (2) Traumatic Brain Injury (3)
* Vacancy Supervisory Position + Not Referred - Ineligible Indicator » Vacancy USAJOBS Ann. Type (Is Internal Merlt Promotion)
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Applicant List Report

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

Tabular report displaying a list of all applicants and applicants by eligibility associated with one or more vacancies.

Applicant List Applicants by Eligibility Data Definitions

Applicant List Report

Organizations: (OPM Reimbursable

Offi . Kansas City Services Branch, Mid-Atlantic Services Branch, Philadelphia Services Branch, San Antonio
ices: Services Branch, San Francisco Services Branch, Washington Services Branch

Customers: All parameter options

Vacancy Numbers: All parameter options

Announcement Open Date Range:

Staffing Staffing Vacancy Vacancy Vacancy Vacancy Announcement Vacancy
N A

Between Jan 1, 2020 and Jul 29, 2020

Series:
Grades:
Eligibilities:
Notification Message Codes:

Organization  Office Customer Number Pay Job Title

Name Name Name Plan- Types
Series-
Grade
OPM Kansas 102 10108764 GS- Human ST-10108764- ST
Reimbursable City Regression 0201- Resources  20-AW
Services Test 911 Specialist
Branch

Query Items:
Adjudicated Eligibility

* Adjudication Status

» Office Name(s) «  Announcement Number

*  Applicant Email Address

* Applicant First Name

Range *  Applicant Last Name

* Applicant Middle Name

Required Prompts:

* Organization Name(s)

* Announcement Open Date

* Application Grade
* Application Number
* Application Series

*  Application Final or Display Rating

Appllcntlon Application Ap Appli Appli Appli Email Address R
Status Lnsl First Middle ]
Name Name Name I
AFPHU- Not Davis Test Delrico R delricodavis@opm gov A
TARO Selected
«  Claimed Eligibility Label *  Application Status

Claimed Eligibility Type * Vacancy Job Title
Lowest Acceptable Grade  *  Vacancy Number
«  Staffing Office Name *  Vacancy Customer
«  Staffing Organization Name *  Record Status Code
»  Veterans Preference Claimed
»  Vacancy Pay Plan-Series-Grade

Veterans Preference Adjudicated

Vacancy Announcement Types
*  Application Rating Notification Message

Application Rating Notification Message Code
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New Hire Detail Report

BB Teamcontent > USA Staffing Packages and Folders > Hiring Data Warehouse

This report displays a list of new hires by Organization, Office, and Customer, with detailed information about the request
associated with the new hire, new hire status, and completion dates of tasks included in typical onboarding workflows.

-
New Hires Data Definitions
New Hire Detail Report
E‘Clrganizaticms: Office of Personnel Management, OPM HR Selutions Date Type: Actual Start Date
Offices: HRS OPM Office, Office of Personnel ManagementHRO Date Range: Between Dec 1, 2021 and Jan 6, 2022
Customers: All parameter cptions Vacancy Numbers: All parameter options
New Hire Status: All parameter options Request Type: All parameter options
New Hire Series: All parameter options
New Hire New Hire New Hire New Hire | New Hire | New Hire New New Hire | New New Hire New Hire e-Verify Case Onboarding | Onboarding Process Owner | New Hire | New Hire New Hire Vacancy | Vacancy Job | Certificate | Certificat
Staffing Staffing Staffing Last Name First Middle Hire Creation Hire Position Status Number Process Email Request = Request Last Number Title Number | Applicatic
‘Organization | Office Name Customer Name Name Number Date Pay Title Owner Number Type Updated Number
Name Pl?n- DateiTime
Grade
Office of Office of CIO Federal BAKER PATRICIA | BATASHA | HL73M- | 10/07/2021 | GS- IT Active 2021340180018AC | Moises moises.cartagena@opm.gov | 20211007- | Onboard | 12/15/2021
Personnel Personnel IT Business 06P8 22107 | SPECIALIST Cartagena 11891 New Hire |11:26:36.100
Management | Management | Solutions (CUSTSPT) PM
Required Prompts; Query Items:
- Organization Name(s) New H!re Staff!ng Orgamzatlon + e-Verify (;ase Number + Tentative Job Offer
* New Hire Staffing Office * Onboarding Process Owner Response Date/Time
» Office Name(s) + New Hire Staffing Customer < Onboarding Process Owner Email  + Receive Tentative
. Staffing Date Range* New H!re Lgst Name * New H!re Request Number Respons.e.CompIeted
* New Hire First Name * New Hire Request Type + Sent Official Offer
» Actual Start . . . .
« New Hire Creation * New Hire Middle Name * New Hire Last Updated Date/Time Completed Date
- Projected Start * New Hire Number » Vacancy Number + Official Job Offer
+ Request Creation * New Hire Creation Date * Vacancy Job Title Response
* New Hire Pay Plan-Series-Grade « Certificate Number « Official Job Offer
* New Hire Position Title * Send Tentative Offer Completed Date Response Date/Time
* New Hire Status + Tentative Job Offer Response * ..Mmore
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Other Report Topics

« Certificate Status Dashboard * Application Assessment Q's and A's Detail Report
* Vacancy Overview Dashboard + DEU Announcement List with Selections
* Vacancy Case File Documents Audit Report » User License Office Totals

* Application Notes * Application Overview Report

* Recruitment Sources By Vacancy Report » Task List

« Certificates to be Audited * Requests Pending Announcements

« Applicant List by Notification Message * Incomplete Applications Report

* Assessment Content Report + eOPF Transmission Report

* Assessment Items by Competency * Open Announcements Not Released

« Applicant Scores by Assessment * Announcement Log with Applicant Totals
»  Workflow Detail Report « Vacancy Information For Requests

» Closed Announcements Pending Certificates +« DEU Announcement List with Selections and

» Certificate Log with Applicant Totals Effective Date of Appointment

* Overdue Certificate Log « Applicant List By Record Status Code (RSC)

» Certificates with Selections * Competencies Report

« Vacancy Log With Applicant Totals And many more!
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What's New? | Release Notes

2 Week Sprint Cycles / Continuous Improvement
https://help.usastaffing.gov/ResourceCenter/index.php/Reporting and Analytics

Reporting and Analytics

Cognos Training Resources

e Cognos AFD Report Authors Training Presentation (October 2019) |

s Cognos Consumer Quick Start Guide (December 2020) B
e Cognos Training Videos &

e Report Author Training for Beginners {June 2021) B

s Report Author Training for Advanced Users (June 2021) B

E Reporting and Analytics Release Notes

e Reporting and Analytics Release Notes - December 15 2021 B
® Reporting and Analytics Release Motes - December 1 2021 B
e Reporting and Analytics Release Notes - November 17 20211

Previous Reporting and Analytics Release MNotes

rj Power BI Training Resources
al|

+ Coming Soon

.E. Reporting and Analytics Workgroup Meeting
Ha® Materials

+ December 21 20218
* November @ 2021 B
» September 28 2021 [

Previous Workgroup Meeting Slides

Reporting Package Resources

HDW Application Metrics Job Aid (March 2021) B

HDW Assessment Reporting Job Aid (August 2021) B

HDW Certificate Metrics Job Aid (January 2021) B

HDW Data Relationships Job Aid (September 2021}

HDW Vacancy Metrics Job Aid (July 2021) B

HDW Workload Metrics Job Aid (March 2021) B

Hiring Data Warehouse Data Dictionary (December 2021) &
Time to Hire Overview B

User License Data Warehouse Data Dictionary (July 2021) &
User License Data Warehouse Job Aid ((November 2021) |

For more information or questions on interconnections, reporting, and
analytics, please review the Interconnections, Reporting, and Analytics
Fact Sheet (October 2017) B

qE Reporting and Analytics Workgroup Meeting
Recordings

+ December 21 20216
e November @ 2021 &
» September 28 2021 &

Previous Workgroup Meeting Recordings

The passcode for Zoom recordings is: RRAWOrkagroup
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Reporting Best Practices



USA Staffing

Best Practices for Performance Optimization

Subscription Management — When setting up subscriptions, always
establish an end date. Monitor the success of reports and cancel
perpetual failures until resolution. Don’t be a data hoarder — subscribe
to the reports you need, with a reasonable delivery frequency.

Strategic Run Time- Schedule larger reports to run during off-peak
hours.

Background Job- Use background jobs to allow you to continue
working in Cognos or logout while the report runs. A notification can
be set up to alert you when the report is ready.
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Best Practices for Prompt Pages

Apply Filters — The scope of USAS data is vast. Running a report
without filters can result in poor performance or report failure. Apply
filters when running your report to query a manageable scope of data.

Select None v. Select All - Select None captures full scope by
applying no filter, versus Select All which applies all filter values and
can be resource intensive, especially when searching text fields against
filter. Use Select None for best performance (unless prompt is
required).

Be Patient — Cancelling your report after submitting prompt page

parameters repeatedly will fill up your queue in the background,
draining resources.
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Best Practices for Reporting Issues

Make Sure it is a Legitimate Issue | False Alarm Examples

USA Staffing® ® & D
|

Q: Where is my download?

A: Expand the ‘blank’ browser window. Although
it says your report is ready, it is still downloading
and will be displayed in a Downloads ribbon at
the bottom of the browser window when
complete.

o Q: My report isn't working (‘No data available’).

& A: This report has successfully run and the filters
& applied result in data available because there are
o no records matching the filter criteria. Adjust your

filters and try again..
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Best Practices for Reporting Issues

Legitimate Issues will almost always include an error message which
provides context clues for resolution. Provide the following details when
reporting your issue:

* Name of the Report

« Path/Location of the Report

 Filters applied

« Approximate date/time report was run/failed
« Error message details

Vv Details:

USA Staffing” E ~

<img src="/apology_files/logo.png" /> XQE-DAT-0001 Data source adapter error:
/ . .
0w T‘}D o com.microsoft.sqglserver,jdbc.SQLServer
o The report could not run because SORPon > . .
<div> Exception: Could not allocate space for object
<div style="font-size: 12pt"> i
Q Options: <div>We are not able to display the page requested at this time.</div><br /><br /> dbo.WORKFILE GROUP large record overflow
« C Refresh <div>PIeas¢ try refreshing the page. If you lcominue ?o receive the error, <br />please pr storage: 141806662582272" in database
D <div><br />Thank you for your patience.</div><br /> X i .
<p><font colomss@TSASD">Reference # <span>21edeb70681641318490.3eacfde</spq '‘tempdb’ because the 'PRIMARY" filegroup is
e Close this report = . .
2 i full. Create disk space by deleting unneeded
</div> files, dropping objects in the filegroup, adding

<br /><br />

additional files to the filegroup, or setting
autogrowth on for existing files in the filegroup.
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Scenario 1

Your supervisor is looking for an overview of certificate activity metrics
in support of a briefing for senior leadership. Which Cognos report
would you use and why?

What information would you need from your supervisor (at a minimum)
to run the report?
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Scenario 2

There is a concern that your office is not meeting its EEO recruitment
goals. Which report would you use to measure progress?

If you don't have access to this report, how would you request it?



USA Staffing

Scenario 3

As an onboarding process owner, a colleague has requested a report
that would allow them to monitor the New Hires that are in the process
of onboarding. Which report should be used for this?

Your colleague tells you they are confused by the number of New Hires

not equaling the number of EODs when looking at historical data. Why
might this be?
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Scenario 4

My report results say there is “No Data Available”. What should | do to
troubleshoot this result.
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Scenario 5

| changed the scope of my prompt values and still “No Data Available”. |
know for a fact that a record exists in the Staffing system which should
be reflected in the scope of data | am querying. What do | do next?
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Scenario 6

Cognos is not performing as expected for any number of reasons. What
is your first line of defense in support of troubleshooting?
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Resources and Contacts

Reporting and Analytics Workgroup
A workgroup held with all agencies every six weeks to review updates to data models and reports,
demonstrate new features, and answer your report author questions

Need Help?

If you are experiencing issues accessing Cognos or need help to create or troubleshoot a report,
submit a HelpDesk ticket through USA Staffing.

HR Users Report Author Only and AFD Users
Submit a ticket through USA Staffing Contact your internal USA Staffing Lead or
Account Manager to submit a ticket on your
& o behalf

Review Online Help

Submit a Help Ticket

Still Need Help?
USAStaffingData@opm.gov




